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This Herschel OBSM nominal procedure is used to exe cute the PACS 
DPU OBS full image upload in instrument INIT mode ( OBS upload 
from Application SW). It is called by the FOP PACS procedures 
H_FCP_PAC_NLDM and H_FCP_PAC_RLDM.
The OBS image is loaded into the PACS DPU PM-High m emory and the 
image integrity after upload is checked via checksu m calculation 
and verification.

The copying of the OBS image from PM-High to PM-Low  and OBS 
restart is executed in the calling procedure H_FCP_ PAC_NLDM or 
H_FCP_PAC_RLDM.
The calling procedure also includes the PM-High OBS  image 
checksum verification and updated OBS version numbe rs 
verification.

This procedure assumes that the memory load and mem ory check 
command stacks have already been generated using th e OBSM system 
and are ready for loading on the Manual Stack. The command stack 
generation activity is not covered by this procedur e.

Note: The PACS DPU OBS upload in instrument RESCUE mode can be 
conducted via procedure H_FCP_OBS_4112.

CDMU in Operational Mode
- PACS in INIT mode (DPU ASW running)

Memory areas are Loaded through TC(6,2) and Checked  through 
TC(6,9); this TCs will be delayed when there is an ongoing:
- TC(6,2) Load Memory Using Absolute Addresses
- TC(6,5) Dump Memory Using Absolute Addresses
- TC(6,9) Check Memory Using Absolute Addresses
- TC(8,4,1,1) Copy Memory

Start of Procedure

CDMU in Operational Mode
- PACS in INIT mode (DPU ASW running)

End of Procedure

Same as start except:
- New PACS DPU OBS image loaded in DPU PM-High memo ry

Input Command Sequences

Output Command Sequences

OFCP4110        

Procedure Summary

Objectives

Summary of Constraints

Referenced Displays

Reference File(s)

Spacecraft Configuration

e
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Procedure Summary

e

ANDs GRDs SLDs
PA000380    
PA029380    

DATE FOP ISSUE VERSION MODIFICATION DESCRIPTION AUTHOR SPR REF

 30/01/08   1 1 Created  lstefanov-hp    

 17/06/09     2

1. added current steps 2 and 3, with sub-steps, to dump the PACS DPU OBS image from 
PM-Low before patch�
2. step 4 and sub-steps updated to separate patch stack load from check stack load and 
stack load for Nominal and Redundant�
3. added current step 6 to separate check stack load from patch stack load�
4. current steps 6 and 7 and sub-steps updated for verification via checksums of the whole 
DPU OBS image in PM-High�
5. added current step 8 to include return to calling procedure and instruct for DPU OBS 
image dump from PM-Low  lstefanov-hp    

 19/07/09     3

1. steps 4.3, 5, and 6.3 updated for PACS DPU OBS v.9.04�
2. step 8 updated to include start addresses and lengths for PACS OBS v.9.04 image 
dump from PM-Low  lstefanov-hp    

 24/07/09   2.5 4

1. step 3 updated: added comment indicating the OBSM CT used to monitor only seg_init 
and seg_pmco dump�
2. step 8 updated: corrected typo in start address values for OBS image dump from PM-
Low�
3. step8: replaced H_FCP_OBS_4143 (GI update) by H_FCP_OBS_4142 (dump 
monitor) in OBS dump from PM-Low related comments  lstefanov-hp    

Configuration Control Information
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Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

Beginning of Procedure

OFCP4110
TC Seq. Name :OFCP4110 (  )
Load PACS DPU OBS from ASW and check image

TimeTag Type:  B
Sub Schedule ID: 

 �

 1      Verify initial conditions

 

 Next Step:
  2

Check PACS instrument in INIT mode (DPU ASW running)  

Instrument SOE to confirm PACS instrument mode  

Note:
Initial conditions are verified in calling procedur e 
H_FCP_PAC_NLDM or H_FCP_PAC_RLDM.

 

 

 2      Manual Stack manipulation
Load command stack file for PACS DPU current OBS du mp 
on Manual Stack

 

 Next Step:
  3

NOTE:
The current procedure assumes that the memory dump in 
Live mode is performed using commands with immediat e 
execution.

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 2.1    IF
PACS Nominal

 

   

Select file

PADPRMPR_DI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADPRMPR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

e
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File name examples

- No model associated to the memory image:

PADPRMPR_DI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

- CT PADPRMPR1, ID 0003, Version 001 associated to the 
memory image:

PADPRMPR_DI_0002001_C_PADPRMPR1_0003001_2007_337T09332
0.sun043

 

 

 2.2    ELSE
PACS Redundant

 

   

Select file

PADRMPRR_DI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADRMPRR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name examples

- No model associated to the memory image:

PADRMPRR_DI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

- CT PADRMPRR1, ID 0003, Version 001 associated to the 
memory image:

PADRMPRR_DI_0002001_C_PADRMPRR1_0003001_2007_337T09332
0.sun043

 

 

 2.3    Check memory dump command stack loaded 

 

   

Note:
The PACS DPU OBS image is dumped from the PM-Low area

 

For PACS DPU OBS v.9.03:

Start Address = 00.0000 hex
End Address   = 01.0CC1 hex
Length        = 10CC2 hex

 

IMPORTANT:
# of TCs, Address and Length values in the following 
sub-steps are applicable to PACS DPU OBS v.9.03
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e

Note:
The ' Length' parameter of the memory dump command is a 
16-bit long parameter. A memory dump TC can cover a  
number of 65535 dec ( FFFF hex) SAUs.

 

 

 2.3.1  Check number of memory dump commands in the  stack

 

   

Check that loaded stack contains:
   2 TCs PC028380

 

 

 2.3.2  Check memory ID

 

   

Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the PC028380 commands is 
set to 01 hex:

Memory ID = 01 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                   DPU_MEMORY_DUMP

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : DUMP OF A DPU MEMORY AREA
This Telecommand will not be included in the export

      PC028380

01xx hex  
 <hex> (Def)
 <hex> (Def)

TC  

 

 2.3.3  Check start address and length of first com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the first PC028380 command:

Start Address = 00.0000 hex
Length        = FFFF hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.
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e

Execute Telecommand
                                   DPU_MEMORY_DUMP

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : DUMP OF A DPU MEMORY AREA
This Telecommand will not be included in the export

      PC028380

0100 <hex> 
0000 <hex> 
FFFF <hex> 

TC  

 

 2.3.4  Check start address and length of second co mmand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the second PC028380 command:

Start Address = 00.FFFF hex
Length        = CC3 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                   DPU_MEMORY_DUMP

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : DUMP OF A DPU MEMORY AREA
This Telecommand will not be included in the export

      PC028380

0100 <hex> 
FFFF <hex> 
CC3 <hex> 

TC  

 

 3      Dump PACS DPU current OBS image

 

 Next Step:
  4

Note:
The PACS DPU OBS image is dumped from the PM-Low area

 

Note:
Only the seg_init and seg_pmco memory areas will be 
monitored against the ground reference image.

An OBSM Configuration Table memory model will be used 
to declare the following PACS DPU PRAM areas " To Be 
Monitored":

For PACS DPU OBS v.9.03:

seg_init
Start Address = 00.4000 hex
Length        = 1551 hex

seg_pmco
Start Address = 00.5551 hex
Length        = B771 hex
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e

 

 3.1    MCS OBSM preparation for Image monitor in L IVE mode

 

   

Note:
It is assumed that the OBSM application is already 
running and the OBSM Desktop is displayed on the MC S 
client.
Starting the OBSM application is not covered by the  
current procedure.

 

 

 3.1.1  Select 'Image MONITOR' from the menu

 

   

Select the Image menu of the OBSM Desktop .

From the Image menu, select Monitor. 

The 'Image Catalog' window opens.

 

 

 3.1.2  Select image to be monitored

 

   

 

 
3.1.2.1

 IF
PACS Nominal

 

   

Select the image to be monitored for the memory dev ice 
PADPRMPR.

The 'Image MONITOR' window opens.

 

 

 
3.1.2.2

 ELSE
PACS Redundant

 

   

Select the image to be monitored for the memory dev ice 
PADRMPRR.

The 'Image MONITOR' window opens.

 

 

 3.1.3  Start dump TM processing

 

   

In LIVE mode, processing of incoming real-time 
telemetry starts automatically after the image 
selection.

 

 

 3.2    Upload commands to dump the PACS DPU curren t OBS 
image

 

   

Page 8 of 21
Status      : Version 4 - Unchanged
Last Checkin: 24/07/09 



Doc No.   :PT-HMOC-OPS-FOP-6001-OPS-OAH
Fop Issue :                         3.0
Issue Date:                    13/04/10

  Load PACS DPU OBS in instrument INIT mode

  File: H_FCP_OBS_4110.xls

  Author: lstefanov-hp

Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

e

Uplink the PC028380 memory dump commands with ARM-GO  

For each command, several TM(6,6) packets must be 
received on ground.

 

 

 3.3    Verify reception of TM(6,6)

 

   

Note:
One or more TM(6,6) packets will be received for ea ch 
memory dump command uplinked.

 

 

 3.3.1  IF
PACS Nominal

 

   

Verify Packet Reception

PACS_MEMORY_DUMP
Packet Mnemonic :        MEMORY_DUMP
APID :                   1152
Type :                   6
Subtype :                6
PI1 :                    
PI2 :                    
 

 3.3.2  ELSE
PACS Redundant

 

   

Verify Packet Reception

PACS_MEMORY_DUMP
Packet Mnemonic :        MEMORY_DUMP
APID :                   1153
Type :                   6
Subtype :                6
PI1 :                    
PI2 :                    
 

 3.4    Check OBSM dump packet processing

 

   

Check that the OBSM is processing the incoming memo ry 
dump packets.

 

 

 3.5    Check contents of memory dump packets

 

   

Verify that there are NO OBSM reported differences 
between the memory dump data and the ground image u sed 
for monitoring.

 

IF there are differences reported by OBSM between the 
dump data and the ground image, the merged image shall 
be saved for offline analysis.
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 3.5.1  Save merged image

 

   

IF there are mismatches reported by OBSM, save merged 
image with new ID.

 

Conduct off-line analysis of the reported mismatche s.  

 

 4      Manual Stack manipulation
Load command stack file for OBS load on Manual Stac k

 

 Next Step:
  5

NOTE:
The current procedure assumes that the memory load is 
performed using commands with immediate execution.

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 4.1    IF
PACS Nominal

 

   

Select file

PADPRMPR_PI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADPRMPR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

PADPRMPR_PI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 4.2    ELSE
PACS Redundant

 

   

Page 10 of 21
Status      : Version 4 - Unchanged
Last Checkin: 24/07/09 



Doc No.   :PT-HMOC-OPS-FOP-6001-OPS-OAH
Fop Issue :                         3.0
Issue Date:                    13/04/10

  Load PACS DPU OBS in instrument INIT mode

  File: H_FCP_OBS_4110.xls

  Author: lstefanov-hp

Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

e

Select file

PADRMPRR_PI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADRMPRR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

PADRMPRR_PI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 4.3    Check memory load command stack loaded 

 

   

For PACS DPU OBSW v.9.04:

The start address of the PADPRMPR memory image used  
for memory load command stack generation is 00.0000 
hex, and the last address in the image is 01.0CB4 hex.

The offset applied to the memory image for OBS upload 
in PM-High is 03.0000 hex.

Consequently, the first address to be loaded is 
03.0000 hex, and the last address is 04.0CB4 hex:

Start Address = 03.0000 hex
End Address   = 04.0CB4 hex
Length        = 10CB5 hex

 

IMPORTANT:
# of TCs, Address and Length values in the following 
sub-steps are applicable to PACS DPU OBS v.9.04

 

 

 4.3.1  Check number of memory load commands in the  stack

 

   

Check that loaded stack contains :
   1811 TCs XC001998 for OBS v.9.04

 

 

 4.3.2  Check Memory ID
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Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the XC001998 commands is 
set to 01 hex:

Memory ID = 01 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  PACS Memory Load

Command Parameter(s) :
                     Memory ID            XH000998
                 Start Address            XH001998
               Length of Block            XH003998
       Var length octet string            XH004998
                      Checksum            XH005998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 30      
Det. descr. : Load PACS Memory Using Absolute 
Addresses

      XC001998

01xx hex  
 <hex> (Def)
 <dec> (Def)
 <hex> (Def)
 <hex> (Def)

TC  

This Telecommand will not be included in the export

 

 4.3.3  Check start address and length of first com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the first XC001998 command:

Start Address = 03.0000 hex
Length        = 38 dec

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  PACS Memory Load

Command Parameter(s) :
                     Memory ID            XH000998
                 Start Address            XH001998
               Length of Block            XH003998
       Var length octet string            XH004998
                      Checksum            XH005998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 30      
Det. descr. : Load PACS Memory Using Absolute 
Addresses

      XC001998

0103 <hex> 
0000 <hex> 
38 <dec> 
patch data  
calculated by OBSM  

TC  

This Telecommand will not be included in the export

 

 4.3.4  Check start address and length of last command in the 
stack
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With the Manual Stack in 'Full mode', check  the Start 
Address and Length in the last XC001998 command:

Start Address = 04.0CAC hex
Length        = 9 dec

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  PACS Memory Load

Command Parameter(s) :
                     Memory ID            XH000998
                 Start Address            XH001998
               Length of Block            XH003998
       Var length octet string            XH004998
                      Checksum            XH005998

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 30      
Det. descr. : Load PACS Memory Using Absolute 
Addresses

      XC001998

0104 <hex> 
0CAC <hex> 
9 <dec> 
patch data  
calculated by OBSM  

TC  

This Telecommand will not be included in the export

 

 5      Upload PACS DPU OBS image in PM-High

 

 Next Step:
  6

Uplink the XC001998 memory load commands with ARM-GO  

For each TC XC001998 successfuly executed on-board, 
the DPU HK counter DP_COM_REC_DPU should be 
incremented by one.

After all XC001998 TCs have been sent, the value of  
the counter should be:
   incremented by 1811 for PACS DPU OBS v.9.04

 

Note:
The following value corresponds to PACS DPU OBS v.9.04

 

Verify Telemetry
                DP_COM_REC_DPU            PM056380    = incremented 

by 1811 dec 
AND=PA000380

For each TC XC001998 successfuly executed on-board,  a 
TM(1,1) and TM(1,7) packet shall be received on 
ground.

 

 

 5.1    IF
PACS Nominal

 

   

Verify Packet Reception

PACS_TC_ACP_OK
Packet Mnemonic :        TC_ACP_OK
APID :                   1152
Type :                   1
Subtype :                1
PI1 :                    
PI2 :                    
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Verify Packet Reception

PACS_TC_EXE_COMPL
Packet Mnemonic :        TC_EXE_COMPL
APID :                   1152
Type :                   1
Subtype :                7
PI1 :                    
PI2 :                    
 

 5.2    IF
PACS Redundant

 

   

Verify Packet Reception

PACS_TC_ACP_OK
Packet Mnemonic :        TC_ACP_OK
APID :                   1153
Type :                   1
Subtype :                1
PI1 :                    
PI2 :                    

Verify Packet Reception

PACS_TC_EXE_COMPL
Packet Mnemonic :        TC_EXE_COMPL
APID :                   1153
Type :                   1
Subtype :                7
PI1 :                    
PI2 :                    
 

 6      Manual Stack manipulation
Load command stack file for OBS image ckeck on Manu al 
Stack

 

 Next Step:
  7

Note:
The PACS DPU OBS image in the PM-High area is checked

 

Select the File -> LoadStack option from the main 
menu of the Manual Stack window

 

 

 6.1    IF
PACS Nominal

 

   

Select file

PADPRMPR_CI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADPRMPR

as indicated by the OBSM engineer
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IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

PADPRMPR_CI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 6.2    ELSE
PACS Redundant

 

   

Select file

PADRMPRR_CI_XXXXYYY_N_NoModel_NoModel_YYYY_DDDThhmmss.
machine

from directory 

/home/hmcsops/HPMCS/SESSION/current/data/CMD/STACKS /OB
SM/PADRMPRR

as indicated by the OBSM engineer

 

IMPORTANT:

XXXXYYYY = Image ID(X) and Version(Y) -  depend on 
image used for stack generation

YYYY_DDD hhmmss - depend on stack generation time

machine  - depends on the name of the machine used for 
stack generation

 

File name example

PADRMPRR_CI_0002001_N_NoModel_NoModel_2007_254T1233 00.
sun043

 

 

 6.3    Check memory check command stack loaded 

 

   

Note:
The whole OBS image in PM-High is verified after load 
using checksum calculation over the following 2 mem ory 
areas:

For PACS DPU OBS v.9.04:

Start Address = 03.0000 hex
End Address   = 03.FFFE hex
Length        = FFFF hex
Checksum      = 0217 hex

Start Address = 03.FFFF hex
End Address   = 04.0CB4 hex
Length        = CB6 hex
Checksum      = 7FC6 hex

 

IMPORTANT:
# of TCs, Address and Length values in the following 
sub-steps are applicable to PACS DPU OBS v.9.04
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Note:
The ' Length' parameter of the memory check command is 
a 16-bit long parameter. A memory check TC can cove r a 
number of 65535 dec ( FFFF hex) SAUs.

 

 

 6.3.1  Check number of memory check commands in th e stack

 

   

Check that loaded stack contains:
   2 TCs PC029380

 

 

 6.3.2  Check Memory ID

 

   

Display the Manual Stack in 'Full mode' and check t hat 
the Memory ID parameter in the PC029380 commands is 
set to 01 hex:

Memory ID = 01 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  DPU_MEMORY_CHECK

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : REQUEST FOR A CHECKSUM OF A SPECIFIED  
MEMORY AREA
This Telecommand will not be included in the export

      PC029380

01xx <hex>  
 <hex> (Def)
 <hex> (Def)

TC  

 

 6.3.3  Check start address and length of first com mand in 
the stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address in the first PC029380 command:

Start Address = 03.0000 hex
Length        = FFFF hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.
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Execute Telecommand
                                  DPU_MEMORY_CHECK

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : REQUEST FOR A CHECKSUM OF A SPECIFIED  
MEMORY AREA
This Telecommand will not be included in the export

      PC029380

0103 <hex> 
0000 <hex> 
FFFF <hex> 

TC  

 

 6.3.4  Check start address and length of last command in the 
stack

 

   

With the Manual Stack in 'Full mode', check  the Start 
Address in the last PC029380 command:

Start Address = 03.FFFF hex
Length        = CB6 hex

Note:
The Memory ID of the target memory device is stored  in 
the MSB of the 16-bit long Mem ID TC parameter.
The LSB of the same parameter carries the most 
significant 8 bits of the Start Address.

 

Execute Telecommand
                                  DPU_MEMORY_CHECK

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : REQUEST FOR A CHECKSUM OF A SPECIFIED  
MEMORY AREA
This Telecommand will not be included in the export

      PC029380

0103 <hex> 
FFFF <hex> 
CB6 <hex> 

TC  

 

 7      Check OBS image in PM-High

 

 Next Step:
  8

For each TC(6,9), a TM(6,10) packet shall be receiv ed 
on ground.

 

IMPORTANT:
Address, Length and Checksum values in the following 
sub-steps are applicable to PACS DPU OBS v.9.04

 

 

 7.1    Command and verify the first checksum

 

   

Uplink the first PC029380 memory check command with 
ARM-GO
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Execute Telecommand
                                  DPU_MEMORY_CHECK

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : REQUEST FOR A CHECKSUM OF A SPECIFIED  
MEMORY AREA
This Telecommand will not be included in the export

      PC029380

0103 <hex> 
0000 <hex> 
FFFF <hex> 

TC  

 

 7.1.1  Verify reception and contents of TM(6,10)

 

   

Note:
A TM(6,10) packet will be received for each memory 
check command uplinked.

 

 

 
7.1.1.1

 IF
PACS Nominal

 

   

Verify Packet Reception

PACS_MEMORY_CRC
Packet Mnemonic :        MEMORY_CRC
APID :                   1152
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
                     MEMORY_ID            PM129380  = 0103 <hex> AND=PA029380

Verify Telemetry
                 START_ADDRESS            PM130380  = 0000 <hex> AND=PA029380

Verify Telemetry
                        LENGTH            PM131380  = FFFF <hex> AND=PA029380

Verify Telemetry
                      CHECKSUM            PM132380  = 0217 <hex> AND=PA029380

 

 
7.1.1.2

 ELSE
PACS Redundant

 

   

Verify Packet Reception

PACS_MEMORY_CRC
Packet Mnemonic :        MEMORY_CRC
APID :                   1153
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
                     MEMORY_ID            PM129380  = 0103 <hex> AND=PA029380

Verify Telemetry
                 START_ADDRESS            PM130380  = 0000 <hex> AND=PA029380
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Verify Telemetry
                        LENGTH            PM131380  = FFFF <hex> AND=PA029380

Verify Telemetry
                      CHECKSUM            PM132380  = 0217 <hex> AND=PA029380

 

 7.1.2  Verify checksum value

 

   

Check the received checksum against the expected va lue  

Verify Telemetry
                      CHECKSUM            PM132380  =  <hex>

 = 0217 <hex>
AND=PA029380

 

 7.2    Command and verify the second checksum

 

   

Uplink the second PC029380 memory check command with 
ARM-GO

 

Execute Telecommand
                                  DPU_MEMORY_CHECK

Command Parameter(s) :
           DPU_MEMORY_BLOCK_ID            PP009380
               DPU_MEMORY_ADDR            PP003380
               DPU_DATA_LENGTH            PP008380

TC Control Flags :
                                        GBM IL DSE
                                        --Y -- ---
Subsch. ID : 90      
Det. descr. : REQUEST FOR A CHECKSUM OF A SPECIFIED  
MEMORY AREA
This Telecommand will not be included in the export

      PC029380

0103 <hex> 
FFFF <hex> 
CB6 <hex> 

TC  

 

 7.2.1  Verify reception and contents of TM(6,10)

 

   

Note:
A TM(6,10) packet will be received for each memory 
check command uplinked.

 

 

 
7.2.1.1

 IF
PACS Nominal

 

   

Verify Packet Reception

PACS_MEMORY_CRC
Packet Mnemonic :        MEMORY_CRC
APID :                   1152
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
                     MEMORY_ID            PM129380  = 0103 <hex> AND=PA029380

Verify Telemetry
                 START_ADDRESS            PM130380  = FFFF <hex> AND=PA029380
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Verify Telemetry
                        LENGTH            PM131380  = CB6 <hex> AND=PA029380

Verify Telemetry
                      CHECKSUM            PM132380  = 7FC6 <hex> AND=PA029380

 

 
7.2.1.2

 ELSE
PACS Redundant

 

   

Verify Packet Reception

PACS_MEMORY_CRC
Packet Mnemonic :        MEMORY_CRC
APID :                   1153
Type :                   6
Subtype :                10
PI1 :                    
PI2 :                    
Verify Telemetry
                     MEMORY_ID            PM129380  = 0103 <hex> AND=PA029380

Verify Telemetry
                 START_ADDRESS            PM130380  = FFFF <hex> AND=PA029380

Verify Telemetry
                        LENGTH            PM131380  = CB6 <hex> AND=PA029380

Verify Telemetry
                      CHECKSUM            PM132380  = 7FC6 <hex> AND=PA029380

 

 7.2.2  Verify checksum value

 

   

Check the received checksum against the expected va lue  

Verify Telemetry
                      CHECKSUM            PM132380  = 7FC6 <hex> AND=PA029380

 

 8      RETURN
to calling proc.
H_FCP_PAC_NLDM/H_FCP_PAC_RLDM

 

 Next Step:
  END

IMPORTANT:
After OBS image copy from PM-High to PM-Low execute d 
in calling procedure H_FCP_PAC_NLDM/H_FCP_PAC_RNLDM , 
dump the PACS DPU new OBS image from PM-Low using FOP 
procedure H_FCP_OBS_4142.

 

Note:
For PACS DPU OBS v.9.04, the memory area to be dumped 
in H_FCP_OBS_4142 is:

Start Address = 00.0000 hex
End Address   = 01.0CB4 hex
Length        = 10CB5 hex

 

Page 20 of 21
Status      : Version 4 - Unchanged
Last Checkin: 24/07/09 



Doc No.   :PT-HMOC-OPS-FOP-6001-OPS-OAH
Fop Issue :                         3.0
Issue Date:                    13/04/10

  Load PACS DPU OBS in instrument INIT mode

  File: H_FCP_OBS_4110.xls

  Author: lstefanov-hp

Step 
No. Time Activity/Remarks TC/TLM Display/ Branch AIT Comment

e

Note:
For PACS DPU OBS v.9.04, the 2 TCs PC028380 used in 
H_FCP_OBS_4142 to dump from PM-Low will have the 
following parameters: 

First TC PC028380:
Start Address = 00.0000 hex
Length        = FFFF hex

Second TC PC028380:
Start Address = 00.FFFF hex
Length        = CB6 hex

 

 

End of Sequence 

End of Procedure
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